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Upgrade In 

Summary Upgrade Instructions for Integra for Notes 4.6 
 

 
This document is designed to assist users currently utilizing older versions of Integra for Notes to upgrade 
their systems to Integra for Notes 4.6.  A summary of the main new features available in Integra for Notes 
4.6 are available at www.integra4notes.com/whatsnewin/46. 
 
Following these instructions correctly will ensure a smooth transition from one version of Integra for Notes 
to the next.  The step-by-step upgrade process is summarized below and then further defined in detail 
within the subsequent sections of this document.   

 
 If you are upgrading from version 4.2 or older of Integra to Integra 4.6, you will 

require a new license key. 
 
Please read and follow the special instructions for users of Integra 4.2 or older 
found in the next section.   

 
The Upgrade Process 
 
In summary the process of updating your Integra for Notes environment involves the following steps 
which are described in greater detail in the sections below: 
 
1. Request an upgrade to Integra for Notes 4.6 from www.integra4notes.com/upgrade.   
2. Download the Integra.exe installer file which contains the Integra.ntf template file and store this 

in a folder on your PC.   
3. Users of Integra 4.2 or older should wait until they receive the new Integra for Notes 4.6 license 

key.  Upgrading their Integra environment to 4.6 from 4.2 without deploying the new key will 
result in a failure of the system to operate.  

4. Take a backup copy of your existing Integra database(s) and of your current Integra template 
(Integra.ntf). 

5. After obtaining the new license key (only required by users Integra 4.2 or older), run the 
Integra.exe file from the previously chosen folder.  This will allow extraction of the new Integra.ntf 
template to the default Notes data directory of your local workstation. 

6. Sign the template with an ID file authorized to run on the server on which Integra will be 
deployed and which will avoid ECL warnings for your users at runtime. 

7. Modify the Inherit from Design Template property of your existing Integra database(s) to read 
Integra4NotesR45 and refresh the Design of your Integra database from the locally stored 
template 

8. Replace the current license key found in the License tab found in the Configuration page with 
the new Integra 4.6 license key.   

9. Run the Upgrade Documents & Profiles agent.  This is very important. 
10. If you are using scheduling on a Windows based Domino server, re-enable scheduled running 

through the Configuration document using a Notes ID authorized to run restricted agents. 
11. Enable the Integra database for web browser access (optional) 
12. Enable Integra PDF Writer (optional) 

 
The subsequent sections of this document address each of these steps in detail.

http://www.integra4notes.com/whatsnewin/46
http://www.integra4notes.com/upgrade
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1 Obtain the latest Integra template 
 
Integra.exe, containing the 
Integra.NTF template and 
documentation are available to all 
clients with an up to date 
maintenance agreement.  To 
access this template, point your 
web browser to 
www.integra4notes.com/upgrade 
and you will then be presented 
with a screen similar to that shown 
alongside: 
 
You will be required to provide 
certain the details in this form 
consisting of: 
 

Name of Organization – this is 
the name of your organization 
and is used just for logging  
purposes.  It is not the Notes organization name or domain name but just the standard 
name. 

 

Contact Name – this is the name of the person responsible for downloading the upgrade.  
E-mail address – the e-mail address of the person responsible for downloading the upgrade 
and who is to receive the e-mail containing the login details. 

 

Version to Download – this allows you to define the version number that you would like to 
download.  While typically you would choose the default option which would be the current 
shipping version, if you specifically wish to download an older version, this option will allow 
that flexibility. 

 

Current License Key – this field requires you to enter the license key of your current version of 
Integra.  This can be found from the Configuration document where the key is shown in the 
License tab. 

 

 Domain Details – this field contains the Notes name of the certificate used by your server and 
users within your organization.  This field is automatically updated based on the key entered 
in the Current License Key field above as soon as you tab out of the Current License Key 
field.  

 
Following entry of this requested information click on the request 
Download button.  
   
After filling in the Request Form and submitting it, the user will receive an automated email 
containing a link to a temporary page to allow the manual downloading of the same 
Integra.exe installer.  The temporary page is available only for a limited time period and the URL 
provided should be used as soon as possible to download even if the upgrade will occur later. 
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If after receiving the e-mail containing your login details you do not 
download within 48 hours, you may find that the login is no longer 
available.  This would require you to register once more for the upgrade, 

http://www.integra4notes.com/upgrade
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a process which will send another e-mail with new login details. 
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1.1 Select New Licensing Method – only required by users of Integra 4.2 or older 
 
If you are upgrading from Integra 4.2 or older to 4.6, since new licensing options have been 
available since Integra 4.3, you will require a new license key.  
 
Since Integra for Notes version 4.3, Integra software products have been licensed on a per user 
basis instead of the per server basis previously available and is now available in two versions: 

 
 Integra for Notes Designer Edition - allows a user equipped with this license to create and 
edit Integra for Notes profiles.  

 Integra for Notes End-User edition - allows a user equipped with this license to run Integra 
profiles but not modify the design of these profiles. 

 
Unlike previous versions of Integra which were licensed per server, these licenses run across an 
unlimited number of servers within the same Lotus Notes Domain.  This new method brings a 
number of benefits to Integra, it's partner network, new potential customers and the existing 
client base, namely: 

 
 we will be able to offer a lower entry point for Integra for Notes  
 we will be more competitive for customers who have a large number of servers but not 
necessarily a large number of users  

 er be limited by the server, but will be available launching Integra reports will no long
throughout the entire Notes domain  

 ent on clustered servers, development and test the model will enable easier deploym
environments  

 rate (higher) pricing for iSeries and Sun Solaris deployments 
 

Existing licensees of Integra for Notes who have purchased Integra under the server based 

 

no longer sepa

licensing model and are now upgrading to Integra for Notes 4.6 are therefore able to: 

 switch their licensing method to a user-based method.  
OR  

 t method of license moving forward onto Integra for Notes 4.6  
 

e  an end-user based 

ra for Notes End-user Edition 

a for Notes End-user Edition 

 
 on requesting an upgrade to Integra for Notes 4.6 when 

retain tha

Cli nts opting to switch their current server-based Integra for Notes license to
license can convert each server license to one of the following: 
 
Option 1  
100 x Integ
1 x Integra for Notes Designer Edition 
 

ption 2  O
50 x Integr
3 x Integra for Notes Designer Edition 

Clients will need to make their choice
going to www.integra4notes.com/upgrade.  For more details about the new licensing model 
please refer to www.integra4notes.com/licensing/43. 

http://www.integra4notes.com/upgrade
http://www.integra4notes.com/licensing/43
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When upgrading to Integra for Notes 4.6 you will require a new license 
key.  Following your request for an upgrade you will also receive a 
separate e-mail with your new key.   
  
It is important to wait for the new license key to be received prior to 
actually undertaking subsequent steps to refresh the design of your 
existing database as you will otherwise be locked out of the Integra 
application. 

 
 
The Integra upgrade site will recognize that your site is using Integra 4.2 or older and, in this case 
you will be presented with a number of additional options in the upgrade form to allow selection 
of the choice of licensing method to be implemented for your site.  These are shown in the 
screenshot below: 

Shireburn Software Ltd © 2008 – 16th June 2008 
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Once a choice of licensing method has been selected, this is irreversible.  
To ensure you are able to make an informed decision please refer to the 
description of the new licensing found at 
www.integra4notes.com/licensing/43.  

 

 
 
Having made your licensing choice you should receive a new license key by e-mail which needs 
to be updated into Integra for Notes at the appropriate point in the cycle (see section 8). 

http://www.integra4notes.com/licensing/43
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It is important to wait for the new license key to be received prior to actually undertaking 
subsequent steps to refresh the design of your existing database as you will otherwise be locked 
out of the Integra application.  In the event that you do not receive this e-mail within 24 hours, 
please contact support@integra4notes.com. 
 
 

2 Take a backup 
 
Good practice dictates that you should take a backup of your current Integra for Notes 
database as well as the current Integra.NTF template to allow you to recover from any failed 
upgrade and to roll back to your previous version. 
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The taking of a backup is strongly recommended by Shireburn Software 
Ltd. 
 
Since the file name of the template for Integra 4.6 is Integra.ntf as was the 
case with earlier versions of Integra, please ensure that you take a 
backup of your current Integra.ntf file before downloading, possibly 
renaming it to distinguish it from previous versions. 

 
 
 
 

3 Run the Integra SetUp Program 
 
The Integra.exe file is an installer which contains the Integra.ntf template file as well as the user 
documentation.  There are no other executables or DLL’s in this installer. 
 
Having received Integra.exe in your e-mail or downloaded it from the download page 
provided, you should have detached the file to a directory of your choice.  This is a working 
directory from which you will then be able to 
remove Integra.exe after its successful install.   
 
Exit Lotus Notes before running the Integra set up.  
Run the Integra.exe file by double clicking on the 
file in Windows Explorer having identified the 
folder in which you stored it.   
 
On running Integra.exe, you will see a small 
splash screen. In the event that Lotus Notes 
was still running, you will be warned to exit 
through a dialog box. 
 
The Integra Installer Wizard will then be 
presented to the user as shown alongside:  

 

mailto:support@integra4notes.com
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On selecting the Next option, the user will be shown the software license agreement and given 
the opportunity to agree or disagree with the terms of the agreement.  The Accept option can 
only be used once you have scrolled through the license agreement. 
 

 
 
Disagreeing with the terms will result in the exiting from the install process while agreeing will 
proceed to the next stage. 
 
Assuming the user proceeds, the dialog to select the directories will be presented to the user. 
 
Remember to backup your previous Integra template before proceeding 
 
Two sets of files or links will be installed during this 
process: 
 

The Integra.ntf template - as with all Notes 
templates, this file is required to be stored in the 
Notes default data directory.  The Installer reads 
your registry settings to determine the default 
Notes data directory of your local installation and 
this is displayed in the dialog box.  The option to 
change this exists using the Browse.  IT IS 
IMPORTANT THAT THE INTEGRA TEMPLATE IS STORED 
LOCALLY AND NOT ON THE SERVER. 

 

 

Shireburn Software Ltd © 2008 – 16th June 2008 
6 

The documentation files – links to the user manuals available on the Integra web site. 
 
 
The Integra Installer will provide the user with a choice of locations where to deploy the files 
contained in the installer.  The default for the template is the Notes default data directory while 
the links to the documentation defaults to c:\Program Files\Integra for Notes 4.  The directory for 
the documentation links can be modified by the user selecting the Browse button. 
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By proceeding further the user can then select the Program Group that the documentation files 
will be created in.  This allows selection of the files from the Windows Start->Program Files menu.  
The default Group name is Integra for Notes 4.6.  The current list of the user’s groups are 
displayed.  
 

 
 
 
Having selected the group the user is given one final opportunity to confirm: 
 

 
 

 
 
On confirmation the user will see a number of progress bars while the files are copied to the 
chosen directories following which a conclusion screen is presented. 
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4 Sign the Template 
 
So as to ensure the smooth operation of Integra for Notes within your environment, we strongly 
recommend that you sign the Integra template using an appropriate ID used within your 
organization for signing 3rd party applications and which is granted rights in users’ ECL’s.  Should 
you intend using the scheduled facilities of Integra, then the ID should also be authorized to 
execute restricted agents on the server on which Integra is deployed. 
 
 

5 Refresh Design 
 
As with any Notes database, a user with a 
minimum of Design level access to a database is 
able to  refresh or replace the design of a Notes 
database from the template that it is connected 
to. The relationship between a database and its 
template is defined within the Design tab of the 
Database’s properties box.  

 
To upgrade your current version of Integra to the 
4.6 version, set the Design Template on which your 
existing Integra database is to inherit its design from 
within the Design tab of the database properties of 
the Integra database (see screenshot).  The design 
template for Integra for Notes 4.6 should be set to: 
 

Integra4NotesR46 
 
Once this is done, the Integra database is able to 
be updated through the usual manual process of 
refreshing the design of a database from its parent template. This is undertaken using the Notes 
feature in the file menu: File Database Refresh Design.  This option will allow the user to select 
the current Integra database (either on the server or local) and then run the refresh from the 
user’s local workstation to which the Integra template had been deployed. 
 

 
 
It is important that the Integra for Notes 4.6 template is placed on the local workstation of the 
user undertaking the upgrade. 
 
 

 
 

For a database’s design to be refreshed, the current user must 
have a minimum of Designer level of access to the access control 
list of the database.   
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6 Upgrade Documents & Profiles 
 
The new Integra template contains updates to messages and the on-line help.  In addition Integra for 
Notes ships with a number of sample profiles which can be used immediately to provide value to 
your organization as well as the allow you to dissect the profiles as a means of better 
understanding Integra for Notes.  New versions of Integra may contain improvements to 
standard profiles shipped with the product.  The Upgrade Documents & Profiles agent 
automatically upgrades the existing profiles as well as adding any new profiles and updating 
messages and help. 
 
The Upgrade Documents & 
Profiles agent is run through the 
Action menu.   
 

 
 
 

 

.  

Only run the Upgrade Documents & Profiles agent after having 
undertaken the Refresh Design process.   

 
On running this option, the user will be given the opportunity to choose the parameters to be updated: 
 

 
 
In the event that the standard profiles that shipped with Integra had been modified by a user, the modified 
standard profiles will not be updated by this agent.  Should you wish to update a modified standard 
profile, delete the modified profile manually and re-run the Upgrade Documents & Profiles agent. 
 

Shireburn Software Ltd © 2008 – 16th June 2008 
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7 Re-enable Scheduled Profiles 
 
In some situations, Lotus Notes may disable any scheduled agents running on a database when 
that database’s design is refreshed.  Although such an occurrence is rare, if you utilize 
scheduled profiles on a Windows based Domino server, it is prudent to re-enable the agent set in 
Integra which controls the running of profiles which are scheduled. 
 

 

 

Scheduled profiles in Integra can only be executed on a 
Domino server running on a Microsoft Windows™ environment 
or a Lotus Notes client  also running on Windows.  If the 
operating system you use is not Windows, DO NOT  ENABLE 
Scheduled profiles.  

 
To re-enable scheduled profiles, select the 
Configuration view in the Integra navigator.  This 
view is only accessible to users that have been 
granted access to the [Admin] role.  On selecting 
this view, the user will be presented with the 
Configuration document which contains the 
Scheduling tab.  Select this tab. 

 
Select the Enable Scheduled Profiles hot spot in this 
document to trigger the enablement of this agent.  
 
 

8 Replace License Key – only for upgraders from version 4.2 or older 
 
User of Integra for Notes version 4.2 or older will at this point have to replace the current license 
key found in the License tab found in the Configuration page with the new Integra for Notes 4.6 
license key.   
 
 

9 Enable Database for Web  
 
If your Integra database is deployed for usage by web browser users, then you will need to 
enable the Integra database for Web usage.  This is done through the Web tab of the 
Configuration document.  In addition, the actual profiles run via a web browser also need to be 
enabled for the web (see the Integra for Notes Designer’s Manual.  
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The two fields on this configuration page store configuration settings used by the web aspect.  
The field contents are to be as follows: 
 

 Relative Domino Servlet path – this field identifies the 
directory under your default Domino data directory 
which contains servlets.  It is by default called 
/servlet but in case your organization uses a different 
folder to contain servlets, this should be reflected 
here. 
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Servlet url – this field defines the complete url that points to the servlet directory.  This is likely 
to be something like http://everst.acme.com/servlet or http://www.acme.com/servlet.  

 

Use Active-X in Explorer – this option, new to Integra 4.6, allows Integra to be set to allow 
Active-X to be used by users of Microsoft Internet Explorer. 

 

 

 

Due to the security settings of the Domino environment, it is important that 
when these agents are enabled, they are enabled using a Notes ID with 
sufficient access rights to run agents on the server and the appropriate ECL 
settings for accessing the file system. 
 
In addition, since one of the agents deletes documents in the Integra 
database, the ID must also have deletion rights in the ACL of the Integra 
database. 

 
 

10 Enable Integra PDF Writer 
 
While previous versions of Integra have supported various 3rd party solutions for the generation of 
PDF files, Integra for Notes 4.5 onwards now supports its own Integra PDF Writer which is licensed 
for your use across all Integra licensed users.  The Integra PDF Writer is a printer-driver based PDF 
writer and requires the deployment and installation of the writer to the desktop.  This can be 
effected directly through Integra (see section  
 
The installation of the Integra PDF Writer requires three steps: 
 
1. selection of the Integra PDF Writer as one of the required PDF options in the Configuration 

page. 

2. attachment of the Integra PDF Writer executable software into the Configuration page.  This 
enables easier distribution of the executable to end-users, particularly ones that might be on 
remote networks or laptop users. 

3. running of the Integra PDF Writer installation routine by end users on their workstations. 

 
This installation will require a reboot of the PC. 
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10.1 Configure PDF Output 

 
The PDF writing capability needs to be configured by the administrator inside the Integra 
database itself before it can be used.  This is 
done through the Configuration page where a 
tab is specifically dedicated to the PDF 
configuration. 
 
The configuration requires that you first select 
the Integra PDF Writer as one of the PDF 
options in the Configuration page. 
 



 
 
 
 

Integra for Notes 4.6 – Upgrade Manual  Version 4.6  

Following this, the installation requires that the Integra PDF Writer installer is executed on each 
workstation that is to use this capability.   
 
This can be achieved in one of 2 ways: 
 

Distributing the Integra PDF Writer installer to all users by means of deploying it to a file server 
and pointing people to it and allowing them to install the installer 
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Attaching the installer EXE into the PDF tab of the Configuration document found in the 
Integra database as a means of distributing the installer and using the installation command 
in-built into Integra (see section 10.2).  This 
facility ensures that no separate distribution 
of the Integra PDF Writer software needs to 
be made to end users.   

 

 
You can obtain the Integra PDF Writer software 
in either of 2 ways: 
 

point your browser at 
www.integra4notes.com/integrapdf 

 

 
or open the Configuration page of the 
Integra database (you will require access 
to the Admin role in the database’s ACL, 
and move into the PDF tab.  Then click on 
the Integra PDF Writer Downloadbutton.   

 

 
 
 
 
 
 
Either of these options will take you to the appropriate page on the Integra web site which 
contains this executable and allows you to download it to a temporary folder of your choice. 
 
To download the Integra PDF software: 
 
1. Right click on the 

IntegraPDFWriter.exe icon 
at the bottom of the 
page.  

2. Select the Save Target 
As... option.  You will be 
prompted to save the file 
to a directory of your 
choice. Save the 
IntegraPDFWriter.exe file in 
any temporary directory 
on your workstation.  

 
Once the download has been 
effected, open the 

http://www.integra4notes.com/integrapdf
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Configuration document inside your Integra database, open the PDF tab and attach the 
IntegraPDWriterF.exe file into the Rich Text field in the Integra PDF (Client) tab.  
 
Once this is done, the installation on workstations can proceed (see section 10.2 below).  
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10.2 Installing the Integra PDF Writer on the Workstation 

 
Once the Integra PDF Writer software 
has been attached into the 
Configuration page, end-users will be 
able to install the software on their 
workstations.  To install the Integra PDF 
Writer on the workstation, open the 
Integra database and then run Actions -
> Workstation Options -> Install Integra PDF Writer from the main 
Lotus Notes menu.  
 
You will be presented with a page with an Install and an Uninstall 
button.  Select Install and follow the installation wizard.  This installation will require a reboot of 
the PC. 
 
In the event that the user attempts to install the Integra PDF Writer without the administrator first 
having attached the Integra PDF Writer installation EXE in the Integra database, the user will be 
provided with a warning message. 
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Support 
 

 
 
 
Should you have any difficulties effecting the upgrade to Integra for Notes 4.2, please send an 
e-mail to support@integra4notes.com providing as many details about your configuration and 
setup as possible including: 
 
• Your current version of Integra for Notes and the version you are upgrading to 
• Your operating system version of your workstation and client 
• Your version of Word, Excel  
• In the case of a PDF related support issue, the PDF generation product you are utilizing and 

the version number. 
 
 
Contact Details: 

 
 
Shireburn Software Ltd 
Carolina Court 
Guze Cali Street 
Ta' Xbiex MSD 14 
MALTA 
 

 
Tel USA:  (508) 915 4805 
 (650) 276 0506
Tel UK:   (020) 7193 1296 
Tel Europe: (+356) 2131 9977
Fax:  (+356) 2131 9528 
Skype:  integra4notes 

 
support@integra4notes.com 
www.integra4notes.com 
www.integrareports.com 

 
 
Useful web links: 
 
 
www.integra4notes.com
www.integra4notes.com/demo
www.integra4notes.com/faq
www.integra4notes.com//manuals
www.integra4notes.com/support
 
 

 
 

support@integra4notes.com
www.integra4notes.com

 
Tel USA: (508) 915 4805 or (650) 276 0506 

Tel UK: (020) 7193 1296 
Tel Europe: +356 2131 9977 

Fax +356 2131 9528 
 

Time Zone CET (Paris, Berlin, Rome) 
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